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Featured PictureFeatured PictureFeatured PictureFeatured Picture    
of the Monthof the Monthof the Monthof the Month 

 
 

Wind Art 

 

1st Place Advanced Open 

By 

Charlie Brockenbrough 

 
__________________ 

 

 

Special Notice 

 
DUES ARE OVER THREE MO'THS 

LATE ! 

 PLEASE, PLEASE, PLEASE  

PAY 'OW!!! 

EMAIL ADDRESS ralph199@yahoo.com > 
    

May PMay PMay PMay Programrogramrogramrogram    
 

 

 
 

'ick and Alicia Berdeguez            

 
'ick and Alicia are a Father and Daughter 

team. They will be presenting some of their 

personal photos and sharing their 

experiences traveling around the world. 

They will focus on the digital age and the 

ease of sharing your photographs. 

 

 

 

 

 



 

 

Subject Themes for 2008Subject Themes for 2008Subject Themes for 2008Subject Themes for 2008 
 

 

May   'atures Patterns 

June   The Color Yellow 

July   Still Life 

August  Food 

September  Speed 

October  Abstract  

'ovember  Florida History 

December  Best of the Best ( 1st 

Place Winners ) 

 

    

Monthly Competition Monthly Competition Monthly Competition Monthly Competition 
Winners for Winners for Winners for Winners for AprilAprilAprilApril 

 

ADVANCED:- 

 ASSIGNED:- 

  1st  C. Brockenbrough 

  2nd  Stephanie Toups  

  3rd  Stephanie Toups  

  HM  Bob Krakosky   

 

 OPEN:- 

  1st  C. Brockenbrough  

  2nd Amy Holley   

  3rd  Bob Krakosky   

  HM  Claudia Kavanagh  

 

 SAFARI:- 

  1st  C. Brockenbrough  

  2nd  Linda Harrington  

  3rd  Joan Robinson  

  HM  C. Brockenbrough  

 

BEGINNER:- 

 ASSIGNED:- 

  1st  Siman Davies   

  2nd  Penny Sheffield  

  3rd  Rich Tulley   

  HM  Lillian Colella  

  

 

 OPEN:- 

  1st  Sally Campagnone  

  2nd  Jason Holley   

  3rd  Lillian Colella   

  HM  Kyle Berris   

 

 SAFARI:- 

  1st  Kim Rinkinen   

  2nd  Jan Letzring   

  3rd  Jennifer   

  HM  Jason Holley  

 

YTD Point CountYTD Point CountYTD Point CountYTD Point Count 
 

April  Points 

 

Advanced 

 

Stephanie Toups  34 

Amy Holley   16 

Ann Dahm   16 

Joan Robinson  34 

Marlene Daily  24 

Claudia Kavanagh  13 

Bob Krakosky  38 

Steve Underwood   7 

Jim Doan    3 

Larry Crivelli  28 

Charlie Brockenbrough 25 

Linda Harrington   6 

 

 

Beginner 

 

Jason Holley   18 

Betty Karl    7 

Brian Hammersley   8 

Lillian Collella  15 

Phil Carter    4 

Kyle Berris   16 

Kim Rinkenin  36 

Andrew Makal  16 

Sally Campagnone  24 

Kristen Jorolemon  38 

Lois Porter   18 



 

 

Penny Sheffield  25 

Beth Daugherty  11 

Darrel Daily   12 

Rich Tully    8 

Marsha Tucholski   4 

Kathleen Turley   3 

Jan Letzring    9 

Simon Davies   10 

Jenifer Davies   6 

 

 

 

MayMayMayMay Workshop Workshop Workshop Workshop    
 

May Workshop Thursday May 22nd, @ 

7:00pm  

For May we will be having another critique 

of a club wide photo project. 

The subject is the Clock Tower at the beach 

in Daytona. 

You can Park at the Ocean Center parking 

lot and walk through the ocean walk to the 

board walk where you'll see the clock tower. 

That's the closest location. However, if you 

don't mind a little walking, you can park for 

free at SunSplash park and walk north on 

the beach. 

Email photos, about 4x10, 100 dpi jpeg's to 

Bob Krakosky at retiredrks@bellsouth.net . 

He will be able to display them at the 

meeting where we all talk about them, 

sharing insights. If you can not email them, 

have them put on a CD and bring it with 

you. 

 

 

 

Future WorkshopsFuture WorkshopsFuture WorkshopsFuture Workshops    
 

For the benefit of the snowbirds and those 

that will be vacationing elsewhere this 

summer, Jan Letzring has given us a list of 

what’s coming. 

This is of particular interest for the one 

picture workshops hosted by Bob Krakosky. 

 

Here's the list for the rest of 2008. All 

subject matter has not been determined by 

speakers.  

 

May 22 - Clock Tower (One subject, all 

shoot)  

June 26 - Rick Brown (Panoramic)  

July 24 - Bob K. (Table Top)  

August 28 - Rafael Torres (subject not yet 

determined)  

Sept 25 - Dodie Ulery (subject not yet 

determined)  

Oct 23 - Sugar Machine at Sugar Mills 

Gardens (One subject, all shoot)  

'o workshops, of course, for 'ov and Dec.  

 
    

Conklin Center for Conklin Center for Conklin Center for Conklin Center for     
TheTheTheThe    BlindBlindBlindBlind    

 

Photographers needed June 14, 2008  

 
Conklin Center for the Blind 2 mile Walk 

and Pancake Breakfast / exact time to  

be announced later . 

Please let Kathleen Turley know if 

interested . 

Telephone 761-2783 

Email kturley@cfl.rr.com 

    
    
    
    

The Next Safari  The Next Safari  The Next Safari  The Next Safari   
 

May Safari. 
 

May Safari  

Alligator Farm  

HOURS & RATES  

(Group discounts require a reservation)  

Open every day from 9 a.m. until 5 p.m 

 



 

 

Extended summer hours: 9 a.m.- 6 p.m  

 

Regular Admission Rates 2008  

Adults (12 and up) $ 21.95  

Children (Ages 3-11) $ 10.95  

Wheelchairs (Adults) $ 10.97  

Wheelchairs (Children) $ 5.48  

Pass Rates ('O DISCOU'TS)  

Photo Pass $ 69.95  

COUPO'  

Print out our discount coupon and present it 

at the ticket  

counter to receive $1.00 off admission!  

Limit 6 guests per coupon. 'ot to be used 

with other discount offers.  

Coupon must be redeemed at the time of 

offer.  

DIRECTIO'S: 

From I-95, take S.R. 207 (Exit 311).  

Turn east toward St. Augustine.  

Drive 3.7 miles, then turn right on to S.R. 

312.  

Go 3.6 miles, crossing US 1 and going over a 

bridge  

spanning the Intra Coastal Waterway.  

Turn left ('orth) on to A1A/Anastasia Blvd.  

We're located 1 1/2 miles 'orth on the left 

on A1A.  

-

______________________________________

______________________________________

___________  

>>>VISIT THE WI''ER'S GALLERY<<< 

2008 Rookery Photo Calendar Contest  

Rules & Regulations 

The 2008 Rookery Photo Calendar Contest 

is open to  

all 2008 photo pass holders (or those with 

2007  

passes purchased after July 17th 2007). 

Twelve winning photos will be chosen for a 

2009 annual calendar.  

One photo will be judged BEST I' SHOW 

and be rewarded  

with a $500 cash prize. Eleven other photos 

will be chosen  

and each will receive a $200 cash prize.  

One of the goals of this project is to educate 

and bring awareness  

to wading bird conservation. Therefore, a 

portion of the proceeds  

of each calendar will go to the Audubon’s 

Roseate Spoonbill Banding Project.  

All photos must be taken at the St Augustine 

Alligator Farm  

rookery during the 2008 season. Photos of 

birds, alligators, turtles, or other animals in 

the rookery will be accepted.  

Entrants may submit up to FIVE images.  

With each photo submitted, you must fill out 

and attach the entry form.  

Image entries may be color or black and 

white, horizontal or vertical format.  

Entries must be digital images -  

Digital photos are defined as images taken 

with a digital camera  

or scanned traditional photograph saved in 

a digital format.  

Images may be not less than 640x480 and no 

more than 2000x1600.  

Images must be submitted in JPG (at high 

quality) format,  

but file sizes must be less than 5 megs per 

image.  

Please submit all five entries on one disk.  

Minor digital enhancement for cropping, 

red-eye removal,  

filters, corrective functions and legitimate 

manipulations  

such as burning and dodging, brightness 

and contrast, color adjustments,  

saturation, stitching and  

cropping are permitted, but images that 

have been judged  

to be significantly modified or appear 

unnatural will be disqualified.  

'o borders or frames are permitted around 

images  

and no watermarks, signatures, date, or 

copyright notices on images.  



 

 

All submissions become the property of the 

St Augustine Alligator Farm  

Zoological Park (SAAF) and will not be 

returned.  

SAAF may use such photos for advertising 

and/or promotion  

without further compensation. Photo credit 

and Photographer’s  

website information (if available) will 

appear with photo in calendar.  

Credit will not appear in advertising but will 

be applied elsewhere whenever possible.  

SAAF license to use submitted photos is 

nonexclusive;  

photographers retain the rights to the 

original negatives or files.  

Deadline for entries is July 14th, 2008.  

Winners will be notified by August 22th, 

2008.  

Entries that fail to comply with the Official 

Contest Rules will be disqualified.  

______________________________________

______________________________________

______________________ 

Photographers may enter the park an hour 

before opening  

during the rookery season to take advantage 

of the quality  

lighting and greater number of birds.  

This season’s early entry rules are as 

follows: 

2008 Photographer Early Entry Rules  

March 1 – July 14 

To enter the park early (around 8:00am) 

you must  

have a valid PHOTO pass and ID. If you 

have not yet  

purchased a pass, you may enter early by 

giving a credit card  

to the Alligator Farm employee who opens 

the gate.  

The credit card will be charges $59.95 for a 

photo pass.  

You may pick up your pass and credit card 

in the gift shop after 9:00am.  

An Alligator Farm employee will be at the 

red gate at 8:00am  

(or as soon as possible after 8:00am) to 

check passes  

and IDs and allow you entry into the park.  

If you are running late and have missed 

early entry,  

you may politely ask other Alligator Farm 

employees about the  

possibility of entry before 9:00am. You may 

not, however,  

enter through any other gates.  

It is possible that you will have to wait until 

9:00am when  

the park opens for all guests.  

Early entry is for the rookery only. All other 

areas of the park open at 9:00am.  

Make sure you have everything you need 

from your vehicle  

when you enter the park. You may not 

return until the rest of the park is open, at 

9:00am.  

Please keep in mind that the Alligator Farm 

staff still has  

work to do in the rookery. They may need to 

hose and blow areas of the boardwalk.  

Please make sure you give them room to 

work.  

We hope that you enjoy the time you spend 

in our park.  

Please let us know if there is anything that 

we can do for you.  

Photographers may stay after hours during 

the nesting season.  

Ask an animal keeper for details.  

______________________________________

______________________________________

_______________________ 

 

The St Augustine Alligator Farm is more 

than 100 years old!  

Since it's opening in 1893, this popular Saint 

Augustine Attraction  

has been visited by over one million people 

anxious to see  



 

 

the mysterious and dangerous alligator!  

Alligators are a amazing and mysterious. 

Here at the  

St Augustine FL Alligator Farm Zoological 

Park, you can see them up close.  

Among the exhibits you will find at this 

amazing zoological park  

include these species from Florida & 

beyond:  

Maximo - Let's start with the biggest --  

a crocodile that is more than 15 feet in 

length  

and weighing more than 1200 pounds.  

Albino Alligators - The very rare gators 

come from the bayous of Louisiana.  

Land of Crocodiles - Discover crocodiles 

from 'orth  

& South America, Asia and Africa.  

Gomek Forever - a "preserved" massive 

crocodile  

that is more than 18 feet in length.  

Exotic Birds -  

South American toucans and parrots, 

Australian kookaburras  

and emus, Asian pheasants, and African 

turacos are just a  

few of the exotic birds on display at the 

Alligator Farm 
 

 

 

 
 

 Shores Camera club Shores Camera club Shores Camera club Shores Camera club 
OfficersOfficersOfficersOfficers    

 

President - Beth Daugherty 
 

Vice President – Lois Porter 
 

2nd Vice President -   

 

Treasurer – Ralph Jennings 

 

 

 

 

 Shores Camera club Shores Camera club Shores Camera club Shores Camera club 
CommitteesCommitteesCommitteesCommittees    

 

Publicity Representative – Claudia 

Kavanagh 

 
Webmaster -_Stephanie Toup 
 

Programs – Lois Porter 

 

Programs - Joan Robinson 

 

Programs – Lillian Colella_ 

 

Workshops -_Kim Rinkinen 

 

Workshops -_Jan Letzring 

 

Safaris ( Field Trips ) – Joan 

Robinson 

 

Safaris ( Field Trips ) – Beth 

Daugherty 

 

Print Competition – Amy Miller 

 

Print Competition – Ann  Dahm 

 

Print Competition -  Marlene Daily 
 

Focus 'ewsletter Editor -_Ann Dahm 

 

Displays and Exhibits – Airport – 

Larry Crivelli 

Displays and Exhibits –

________________________________ 

 



 

 

Banquets / Parties – Amy Miller 

 

PSA Representative - Stephanie Toup 

 

Interclub Relations and membership -  

Gwen Bills_______________________ 

 

Handbook Editor – Beth Daugherty 

    
Photo TipsPhoto TipsPhoto TipsPhoto Tips    

Submitted by Joan RobinsonSubmitted by Joan RobinsonSubmitted by Joan RobinsonSubmitted by Joan Robinson 

 

I am very sorry I have no tips from Joan this 

month.  She has sent me several the last few 

Months, but as you know my computer died, 

and I have been unable to scavenge data 

from it so far. 

 

However, we got another neat looking one 

from Claudia. 

Thanks Claudia! 

 

Photo TipsPhoto TipsPhoto TipsPhoto Tips    
Submitted by Claudia KavanaghSubmitted by Claudia KavanaghSubmitted by Claudia KavanaghSubmitted by Claudia Kavanagh    

 

Replacing the Sky with Photoshop 

Elements 
 

There’s nothing worse than a white or 

uninteresting sky.  Below is an easy method 

for improvement: 

 

Step One 

Open the photo that needs a new sky 

 

Step Two 

Select the sky that is to be removed using 

the magic wand tool, or any other 

selection tool that you like 

 

Step Three 

Open a sky shot that you had taken 

earlier and were saving just for this 

situation 

Under the Select menu, choose All to 

select the entire sky photo – or use a 

selection tool to pick out part of the 

sky that you’d like to use 

3.   Press Control-C to copy this sky into 

memory 

 

Step Four 

Switch back to the original photo (the 

selection should still be in place) 

Create a new layer using the new layer 

icon or the Layer Menu 

In the new layer, select Paste Into 

Selection from the Edit Menu.  The 

new sky will be pasted into the 

selected area in your new layer, 

appearing over the old sky 

Press Control-D to deselect 

 

Step Five 

If the new sky seems too bright for the 

photo, simply lower the Opacity of 

the layer in the Layers Palette to help 

it better blend into the rest of the 

photo.  That’s it! 

 

SUBJECTS FOR 2008 SUBJECTS FOR 2008 SUBJECTS FOR 2008 SUBJECTS FOR 2008 
DEFINITIONSDEFINITIONSDEFINITIONSDEFINITIONS  

HAND  

The part of the human body attached to the 

end of the forearm  

including the wrist, palm, fingers, and 

thumb. the claw of a crustacean.  

A clapping of hands- to receive a big hand 

for a performance.  

Hands of a clock. the cards held by a player.  

SPEED  

State of moving fast. A vehicle with 5 speeds. 

F- number on a camera  

the widest effective aperture of a camera 

lens.  

YELLOW  

The color of butter, lemons, gold, bananas 



 

 

etc.  

'ATURES PATTER'S  

Wild things, natural scenery including 

plants, animals that are part  

of it-pattern-something to be imitated or 

copied- a plan in making  

things like a house, dress, models, etc. 

Wallpaper patterns.  

STILL LIFE  

Small inanimate objects as fruit, bottles, 

flowers, books, etc used  

as subjects for a picture.  

FOOD  

Substance taken to keep people, animals or 

plants alive-nourishment.  

ABSTRACT  

Designing or of art abstracted from reality, 

in which designs or forms  

may be definite and geometric or fluid and 

amorphous {shapeless, without  

definite form, unorganized, without 

specialized structure.}  

FLORIDA HISTORY  

What has happened in the life and 

development of a people, country,  

institution etc. Florida's recorded events of 

the past. It belongs to the  

past.   
 

If anyone has any questions bring it up or if 

you want to add anything  

to this list-let's talk about it.  
 

 

FYIFYIFYIFYI    
 

This is dedicated to Abstract Photography.  

It's about using a camera not to represent 

something but to create a feeling or 

sensation through the use of shape, color, 

texture, light and shadow.  

 

 

Participation Guidelines  

Inappropriate Images 

'O heavy software editing. 

'O photos of abstract paintings ( e.g., 

simple documents of an existing abstraction 

are not abstract ). 

'O photos of art installations/sculptures ( 

ditto ). 

'O superimposed signatures or copyrights ( 

use meta data please ). 

'O elaborate borders. 

 
 

Beach PhotoBeach PhotoBeach PhotoBeach Photo    
At 604 Main St, Daytona BeachAt 604 Main St, Daytona BeachAt 604 Main St, Daytona BeachAt 604 Main St, Daytona Beach    

 Is offering a 10  Is offering a 10  Is offering a 10  Is offering a 10 ---- 15% discount to our  15% discount to our  15% discount to our  15% discount to our 
club members on certain items to be club members on certain items to be club members on certain items to be club members on certain items to be 

determinedeterminedeterminedetermined by them.d by them.d by them.d by them.    
They do handle used equipment also.They do handle used equipment also.They do handle used equipment also.They do handle used equipment also.    

 

KNL Custom FramingKNL Custom FramingKNL Custom FramingKNL Custom Framing    
At 567 Beville RoadAt 567 Beville RoadAt 567 Beville RoadAt 567 Beville Road    
Golfview PlazaGolfview PlazaGolfview PlazaGolfview Plaza    

Is offering a 50 % discounIs offering a 50 % discounIs offering a 50 % discounIs offering a 50 % discount to our club t to our club t to our club t to our club 
members on matts and matting.  You members on matts and matting.  You members on matts and matting.  You members on matts and matting.  You 
must have Id and membership card must have Id and membership card must have Id and membership card must have Id and membership card 

with you.with you.with you.with you.    

    
    

PersonalsPersonalsPersonalsPersonals    
 

             For SaleFor SaleFor SaleFor Sale 

 
FOR SALE:  

 

$350- EOS Canon 10 D 6.3 megapixels; 

Canon Manual; battery charger; 256- 

compact flash;  

$ 100 Canon Elan II body; Manual & Magic 

Lantern Guide;  

$300 Canon EF 20 mm 1:28 Ultrasonic lens 

Auto focus & case  

Call  Joan Robinson 

 386-761-9296 

 

_________________________________ 

 
 



 

 

 
 
 
 
 
 
 
 
 

   The Shores Camera Club is a member in The Shores Camera Club is a member in The Shores Camera Club is a member in The Shores Camera Club is a member in 
good standing of the: good standing of the: good standing of the: good standing of the:     

                  

he Shores Camera Club Focus Newsletter is an online 
publication of the Shores Camera Club which meets in Daytona 
Beach Shores, FL.  Any comments, suggestions or inputs 
should be directed to Ann Dahm (Editor) at ailiki@earthlink.net 

 

 

 

 

Special Notice Special Notice Special Notice Special Notice A message from your A message from your A message from your A message from your 

friendly Focus editor.friendly Focus editor.friendly Focus editor.friendly Focus editor.  I would really appreciate it, if   I would really appreciate it, if   I would really appreciate it, if   I would really appreciate it, if 
everyone who has to/wants to put something in the everyone who has to/wants to put something in the everyone who has to/wants to put something in the everyone who has to/wants to put something in the 
newsletter would get it to me by the 28newsletter would get it to me by the 28newsletter would get it to me by the 28newsletter would get it to me by the 28thththth o o o of the month.                f the month.                f the month.                f the month.                
Thank you kindly,           Thank you kindly,           Thank you kindly,           Thank you kindly,                                                                   Ann DahmAnn DahmAnn DahmAnn Dahm    

Ailiki@earthlink.net 


